Desigo TRA
Setup & Service Assistant
Commissioning
Table of contents

1  Setup & Service Assistant ................................................................. 4
2  Installing SSA DNT ................................................................. 5
3  Connecting a cable to the room automation station .................... 6
4  Configuring a network connection .............................................. 7
5  Configuring a room automation station ....................................... 11
6  Establishing web connection to room automation station ........... 15
7  Device and network configuration (homepage) ............................ 17
8  DALI status ................................................................................. 19
9  DALI identification ................................................................. 21
10  DALI data point test ............................................................... 23
11  PL-Link identification ............................................................. 25
12  PL-Link data point test ........................................................... 27
13  PL-Link not configured .......................................................... 29
14  TX-I/O status ............................................................................. 30
15  TX-I/O data point test ............................................................ 31
16  Report ......................................................................................... 33
17  Updating firmware ................................................................. 35
18  Defining proxy server settings ............................................... 37
19  SSA-DNT program description ............................................... 38

Index 45
1 Setup & Service Assistant

The Setup & Service Assistant allows electrical installers to configure and test devices on the (IP) network and on the field bus (island bus, PL-Link, DALI). The electrical installer receives the required data via a data package (Pack & Go) created in ABT.

The Setup & Service Assistant consists of two parts:
- The SSA DNT (Discovery and Node Setup Tool) program.
  Use SSA DNT to configure the room automation station in the (IP) network.
- A website on the IP device on the network (IP)
  e.g. in the room automation station, the router, or the web server.
  Configure TX-I/O, PL-Link, and DALI devices using the website on the room automation station. In addition, carry out wiring and data point tests.

**Workflow (overview)**

1. Install SSA-DNT
2. Connect PC to automation station (USB) or network (LAN)
3. Discover automation station on network
4. Configure automation station and load device configuration
5. Configure and test field devices (TX-I/O, PL-Link, DALI)
6. Create installation reports (fieldbus, devices, tests)

**Important/Notes**

All entries are executed directly in the SSA and regularly saved every 15 minutes in non-volatile memory on the room automation station. It is immediately saved with Save and log out. No data is saved on the commissioning laptop.
2 Installing SSA DNT

SSA DNT is a part of the Pack&Go data package.

Prerequisite:
- The project-specific Pack & Go data package (zip file) is located on the commissioning computer.
- The project-specific password is known.

Extracting the Pack & Go zip file
1. Double-click the *.zip file.
2. Enter an empty folder as extraction target.
3. Click OK.
   ⇔ The configuration data for all engineered room automation stations and routers are saved in the specified folder.

Note: Select the language for the SSA DNT via the operating system's Regional and Language Options.

Starting SSA DNT
1. Double-click file SSA-DNT.exe in the unzipped folder (unzip target folder).

   ⇔ The network configuration data is read. The engineered room automation stations are displayed. (Select device configuration table).

2. Open a network connection to the room automation station. See also:
   Connecting a cable to the room automation station [➙ 6]
   Configuring a network connection [➙ 7]

Note: A description of the SSA DNT program user interface is available here: SSA-DNT program description [➙ 38]
3 Connecting a cable to the room automation station

Use a LAN or USB cable to connect the commissioning laptop to the room automation station or router.

LAN cable
The LAN cable connects the commissioning laptop with the network (IP) in two ways:
- The LAN cable is plugged in directly to the room automation station.
- The LAN cable is plugged in at another location on the network (IP).

Prerequisite
- LAN cable Category 5 RJ45 is available.

Procedure
1. Plug in the LAN cable to the commissioning laptop and room automation station.
2. Configure the network connection in the SSA DNT. See Configuring a network connection [➙ 7]

USB cable
The USB cable directly connects the commissioning laptop to the room automation station. The room automation station establishes the additional connection to the network (IP). This has the following effect: The connection between the commissioning laptop and the network (IP) is interrupted (e.g. during configuration, etc.) if the room automation station is restarted.

Prerequisite
- USB cable is available (type A plug on one end and type B on the other).
- USB driver RNDIS exists (load via V5, ACS, BIM tool or Internet).

Procedure
1. Plug in the USB cable to the commissioning laptop and room automation station.
   - The message "New hardware found" is displayed on the commissioning laptop if both devices are operations; a new USB IP network connection (e.g. SBT USB Remote NDIS Network Device…) is generated.
2. Configure the network connection. See Configuring a network connection [➙ 7]
4 Configuring a network connection

As a rule, the commissioning laptop and IP devices (automation station, router, etc.) must be located within the same subnet (e.g. 192.168.251.10, subnet mask 255.255.255.0 and 192.168.251.20, subnet mask 255.255.255.0):

- The existing IP address with subnet mask is key for configured IP devices.
- The IP address with subnet mask (target address) to be configured is key for unconfigured IP devices.

If a network (IP) contains multiple PCs (e.g. with SSA or ABT) connected at the same time, each PC must have its own, unique IP address. If no DHCP server is available, a LAN connection with unique IP address must be configured on the commissioning computer. See: Configuring a network connection.

A second IP address must often be configured on the same network card. See: Configuring a 2nd network connection.

In the SSA DNT program, network connection settings can be queried directly via the IP settings button (same as Start > Control Panel > Network Connections in the Windows operating system).

Prerequisite

- The IP addresses for Desigo TRA are known. Unique, corresponding IP address with subnet mask is known for the commissioning laptop (ask your project manager).
- The SSA DNT program opens.

Configuring a network connection

1. In the SSA DNT, click IP settings.

   - The Network connections pane opens.

2. Double-click the LAN network interface or double-click the USB network interface (e.g. SBT USB Remote NDIS Network Device…).

   - The Status for dialog box opens.
3. Click Properties.

   Click Properties.

5. Select Use following IP address.

6. Enter the IP address (IP address range for Desigo TRA).
7. Enter the subnet mask (e.g. 255.255.255.0)
8. Confirm by clicking OK and close the dialog box.
   The network connection was assigned a fixed IP address.
Configuring a 2nd network connection (additional IP address)

1. In the SSA DNT, click IP settings.

   The Network connections pane opens.

2. Double-click the LAN network interface or double-click the USB network interface (e.g. SBT USB Remote NDIS Network Device…).

   The Status for dialog box opens.

3. Click Properties.

5. Select **Use following IP address.**

Click **Advanced.**

6. Click **Add.**

7. Enter the **IP address** (IP address range for Desigo TRA).

Enter the **subnet mask** (e.g. 255.255.255.0).

Click **Add.**

8. Confirm by clicking **OK** and close the dialog box.

✦ The network connection was assigned a second fixed IP address.
Configuring a room automation station

Configuring a room automation station comprises the following steps:

- Discover the room automation station in the network.
- Assign the engineered room automation station to the room automation station in the network.
- Configure room automation station (network configuration/node setup and device configuration) and load configuration data (for field bus and field devices).

Note: The project-specific application is loaded using ABT following room automation station configuration.

Prerequisite

- Use a LAN or USB cable to connect the commissioning laptop to the room automation station or router.
- A network connection (via USB or LAN) is configured. See also: Configuring a network connection [➙ 7]
- The SSA DNT program opens. The configuration data is read.
- The room automation station is operational and unconfigured.

Connecting to the IP network

1. Select the LAN network interface, or select the USB network interface.
2. Select the IP address of the network interface (normally first IP address (default) or IP address of the configured LAN connection).
3. Click Connect.

⇌ The LAN or USB network connection is established (log entry).
Configuring a room automation station

- The status of the network connection is displayed (lower left hand side of the pane).
- For a USB network connection, the connected room automation station is listed immediately in the Select device on network table. You can now configure the room automation station.

Note: An active firewall may prevent access to the room automation station. Either the corresponding firewall pane is displayed or no devices are found with Network scan. Not even the service pin triggers a reaction. Check with your network administrator for detailed procedures.

Entering a password

The password is checked automatically when a connection is established.

- Unconfigured room automation stations have the factory password.
- Configured room automation stations use a project password.

Password entry results in a password query in the background.

- Enter the project password (top right).

Note: The factory or project-specific password are provided separately to the electrical installer (either by phone or in writing).

Discovering a room automation station on the (IP) network

1. Click Network scan.
   - The network is scanned (log entry).
   - The discovered room automation stations and routers are displayed.
   - Unconfigured room automation stations are displayed with device instance number = 4194303.

2. Check to see if the device instance number and address and port on the network differ (for engineered and previously configured room automation stations and routers).

Configuring a room automation station

1. Press the service pin on the room automation station.
   - The room automation station sends out an identification signal as well as device-specific values (firmware version, serial number, MAC address).
   - The room automation station is highlighted in the Select device on network table.

Note: Only the room automation station of the last identification signal is highlighted at any given time. Flash LED can also be used for identification.

2. Select the corresponding, engineered room automation station in the Select device configuration table.

3. Check to see if the identified room automation station should be configured as per the engineered room automation station.

Note: You can only use Configure/load device if the following conditions are met:
- The identified room automation station is NOT configured. (Delete first any existing configuration).
Device type and serial number of the identified and engineered room automation station match.

4. Click **Configure/load device**.

- The configuration data is read. An error message is displayed in the log window when the project password is invalid (window top right).
- The identified room automation station (network configuration/node setup) is configured.
- Device configuration and configuration data (for field bus and field devices) is loaded in the room automation station.
  Note: The default password is required to access the room automation station. Thus, an additional password query pops up if the project password differs from the default password.

- The values in the tables are updated.

Note:
- **Configure/load device** takes about 2 to 4 minutes (including restarting the room automation station).
- If you cannot easily access the service pin, use the Flash LED button to issue a flash command to the highlighted room automation station for identification.
- Multiple room automation stations can be configured, one after the other, using a LAN connection to the room automation station. You do not need to wait each time for a complete configuration.
- Conversely, the USB connection is interrupted to other room automation stations on the network if the room automation station is restarted directly.

Deleting an existing configuration

1. Select a room automation station. (**Select device on network** table).

2. Click **Delete device**.

   Note: Project password required. An error message is displayed in the log window if no valid password has already been entered (top right).

- Beginning and end of a procedure is displayed in the log window (takes about 1 to 2 minutes).
- Table **Select device on network** is updated (Device status = unconfigured, Device status = Download required, Device name = Default Name, Device instance number = 4194303).

- The room automation station no longer is configured (factory default setting).

   The factory password is set.

Note:
- Multiple room automation stations can be deleted, one after the other, using a LAN connection to the room automation station. You do not need to wait for deletion to complete.
- Conversely, the USB connection is interrupted to other room automation stations on the network if the room automation station is restarted directly.
Making the LED flash on the room automation station

Flash LED allows you to verify if the selected room automation station and the device match.

1. Select a room automation station. *(Select device on network table).*
2. Click **Flash LED**.
   - An LED of the room automation station flashes for about 10 seconds.
6 Establishing web connection to room automation station

The room automation station has a web server. For this reason, you can access the homepage for the room automation station (URL) via SSA DNT or your browser (e.g. Internet Explorer > 6). You can use the browser to operate and parameterize a room automation station as well as to configure field bus devices.

Establishing web connection to a room automation station (web server)

Prerequisites

A LAN connection (via USB or LAN) is configured. See also: Configuring a network connection [➙ 7]

- The SSA DNT program opens.
- The room automation station is configured (node setup).

1. Click the link to the room automation station. (Select device on network table; URL Setup & Service Assistant column).

   ➔ The room automation station overview page (homepage) opens. The most important states and properties of the room automation station and the
existing field buses are displayed.

2. Select the desired working pane in the top navigation pane.

3. Select a subpane in the left navigation pane.

Web connection using a browser

If you know the IP address of the room automation station, you can enter the address in the browser or save it under Favorites. This opens the homepage without SSA DNT, but you must still enter the password.

Check your proxy server settings for the browser if the status page does not open.

See also: Defining proxy server settings [➙ 37]

Disconnecting a web connection

1. Check to see if devices or field buses require restarting or if they are in the desired operating state.

2. Select Save and log out in the upper navigation pane.

Note: All entries are executed directly in the SSA and regularly saved every 15 minutes in non-volatile memory on the room automation station. It is immediately saved with Save and log out. No data is saved on the commissioning laptop.
Device and network configuration
(homepage)

The **Device and network configuration** web page shows the operating state and a few configuration properties of the room automation station. You can restart the room automation station or remove all overwritten data points using a command.

Note: All entries are executed directly in the SSA and regularly saved every 15 minutes in non-volatile memory on the room automation station. It is immediately saved with **Save and log out**. No data is saved on the commissioning laptop.

Prerequisites

- A web connection to the room automation station is available. See also: Establishing web connection to room automation station [➙ 15]

Starting a room automation station

- **Click Run** to start the room automation station.

Note: If you cannot start the room automation station via Run, restarting using network off/on is possible.

Remove overwrite

The column **Override** displays whether at least one data point has the status "Overwritten". The command **Remove overwrite** removes the "Overwritten" state for all data points on this room automation station.

1. Ensure on the individual web pages ... **Data point test**, whether you want to remove all overwritten data points.

2. **Click Remove overwrite**.

   All overwritten states are removed. No new commands are issued. The set values remain until the next program command. Priority 8 is enabled.
Reading room automation station configuration properties

1. Click **Details** in the left column.

   The room automation station configuration properties are displayed.

   ![Device and network configuration (homepage)](image)

<table>
<thead>
<tr>
<th>Device properties</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>DL-Device</td>
<td>AS_2</td>
</tr>
<tr>
<td>Object name</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>Webcode</td>
<td>908S2084</td>
</tr>
<tr>
<td>Status</td>
<td>Operational</td>
</tr>
<tr>
<td>Operation URL</td>
<td><a href="http://192.168.1.201:11">http://192.168.1.201:11</a></td>
</tr>
<tr>
<td>Serial number</td>
<td>32340</td>
</tr>
<tr>
<td>Runtime version</td>
<td>IFM10.3.0030d3d5005.10</td>
</tr>
</tbody>
</table>

2. The <Back> button returns you to the previous web page.
   Or: Select the desired working pane in the top navigation pane.
8 DALI status

The DALI status web page shows the current DALI bus status. Execute the following functions:

- Start and stop the DALI bus.
- Automatically address DALI devices
- Execute DALI command test.

Prerequisite
- DALI is selected in the upper navigation pane.
- Status is selected in the left navigation pane.

Starting or stopping the DALI bus

- Click Run or Stop.
  - The DALI bus is started or stopped, and the status displayed (operational/stopped).

Restarting the DALI bus

- Click Reset.
  - All DALI devices are reinitialized (runtime configuration, bus configuration).
  - The DALI bus is restarted, and the status is displayed as Operational.
  - The number of connected and configured DALI devices is displayed.

Automatically address DALI devices (short address)

1. Click Auto addressing.
  - The DALI bus is scanned. The DALI devices discovered contain a DALI bus short address. Existing DALI bus addresses remain as is.
  - The number alongside the button displays ongoing auto addressing and may take a few minutes (depending on the number of DALI devices).
  - Auto addressing does not update the contents of the DALI identification and DALI data point test web pages.

2. Select Identification in the left navigation pane.
   The DALI bus short address and detected DALI device type (device online) are displayed.
displayed on the **DALI identification** web page. After auto addressing is complete.

**Executing a command test**

The command test is used to switch all connected DALI devices to either OFF, ON, or FLASHING.

▷ The DALI bus must be stopped. Only then are the commands **All lights on**, **All lights off**, or **Blink all** active.

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>The &quot;Blink all&quot; function may damage lights. Check if lights whose lifetime is impacted by blinking are connected. This is required for all lights connected to the DALI bus of this room automation station.</td>
</tr>
</tbody>
</table>

1. Click **Stop**.
2. Click either **All lights on**, **All lights off**, or **Blink all**.
   - The switching status remains active until another function is selected, or until the DALI bus is restarted.
3. Select **Run**.
   - This stops the command test.
   - The DALI bus is started.

**Note:** This function can also be run using the service pin on the PXC3..A.
9 DALI identification

The DALI identification web page shows the current DALI bus configuration. This is where you configure DALI devices.

Prerequisite

- DALI is selected in the upper navigation pane.
- Identification is selected in the left navigation pane.
- The DALI bus status is Operational.

Configuring (assigning) DALI devices

A DALI device with DALI bus short address is assigned to an engineered DALI data point and configured (e.g. DALI group).

1. In the Online list table, click the icon to identify that DALI device.
   - The DALI device with the DALI bus short address flashes (e.g. lamp on site).

2. Select Reset device parameters during assignment if you first want to use the DALI device factory setting.

3. Drag and drop the DALI bus short address to the table row containing the engineered DALI data point.
   - The factory setting is executed (option).
   - The DALI device with the DALI bus short address sends its serial number. The serial number is entered in the list.
   - The DALI device is configured using the device configuration data stored on the room automation station.
   - The status display changes to Operational.

Note:
The DALI bus address is transferred to ABT following read back of data.
The DALI bus short addresses can be listed in ABT via the "DALI report".

Resetting DALI devices

- In the State pane, click the icon.
  - The DALI device is reset. The device includes the assigned short address.
  - The serial number is deleted from the table. The status display goes to Unassigned device.
  - The DALI device is now listed in the Online list.
Website description

- **Reset device parameters**: Set the factory setting prior to configuring a DALI device.

If an existing DALI installation is integrated in TRA, existing DALI devices may already be configured. Use **Reset device parameters during assignment** to initialize the factory setting prior to configuring the DALI device and the configuration is loaded.

Online list table

The **Online list** table contains all DALI devices with a DALI bus short address that are still unconfigured.

<table>
<thead>
<tr>
<th>Address</th>
<th>DALI bus short address. Automatically assigned using <strong>Auto addressing</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device online</td>
<td>Read DALI device type. (Unconfigured).</td>
</tr>
<tr>
<td>0 FL</td>
<td>FluorescentLamps</td>
</tr>
<tr>
<td>1 EML</td>
<td>Lamps EmergencyLighting</td>
</tr>
<tr>
<td>2 HID</td>
<td>HIDischargeLamps</td>
</tr>
<tr>
<td>3 LV</td>
<td>LowVoltageHalogenLamps</td>
</tr>
<tr>
<td>4 IL</td>
<td>IncandescentLamps</td>
</tr>
<tr>
<td>5 CONV</td>
<td>DirectCurrentConverter</td>
</tr>
<tr>
<td>6 LED</td>
<td>LEDModules</td>
</tr>
<tr>
<td>7 SWI</td>
<td>SwitchInFunction</td>
</tr>
<tr>
<td>8 RGB</td>
<td>ColorControl</td>
</tr>
<tr>
<td>9 SEQ</td>
<td>Sequencer</td>
</tr>
<tr>
<td>10 OC</td>
<td>OpticalControl</td>
</tr>
<tr>
<td>13 M-SEN</td>
<td>Movement Sensor</td>
</tr>
<tr>
<td>14 B-SEN</td>
<td>Light Sensor</td>
</tr>
</tbody>
</table>

Table of configured DALI devices

<table>
<thead>
<tr>
<th>Show AI</th>
<th>Filters the DALI devices in the table.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search</td>
<td>Searches for the characters in the table.</td>
</tr>
<tr>
<td>Address</td>
<td>Engineered DALI data point.</td>
</tr>
<tr>
<td>Device online</td>
<td>Read DALI device type. (Unconfigured).</td>
</tr>
<tr>
<td>Device offline</td>
<td>Engineered DALI device type.</td>
</tr>
<tr>
<td>0 FL</td>
<td>FluorescentLamps (Standard)</td>
</tr>
<tr>
<td>0 G-FL</td>
<td>Generic Fluorescent (Desigo TRA)</td>
</tr>
<tr>
<td>…</td>
<td>…</td>
</tr>
<tr>
<td>Serial number</td>
<td>DALI device serial number.</td>
</tr>
<tr>
<td>State</td>
<td>DALI device operating state.</td>
</tr>
<tr>
<td></td>
<td>Button to delete the configuration.</td>
</tr>
<tr>
<td>1-7 / 7</td>
<td>Pages1-7; button for browsing.</td>
</tr>
</tbody>
</table>
10 DALI data point test

The DALI data point test web page allows you to test the configured DALI devices and note the results (state, comment). Point test carries out On/Off and dimming (%) commands.

Prerequisite

- DALI is selected in the upper navigation pane.
- Data point test is selected in the left navigation pane.
- The DALI bus status is Operational.

Searching for DALI data points

The navigation functions (bottom right) allow for browsing the display. Select the number of data points to display via the number of entries (top left).

The search function (top right) searches the table for the desired characters. All DALI data points found are displayed in the list.

Switching on or off DALI data points

1. Select the data point's checkbox Overwrite.
   - Manual operation with + and - is enabled.
2. Click + or -.
   - The DALI device is switched on or off. The new value is displayed.

Note: Symbol indicates a faulty value. The tooltip contains the cause (out of service or alarm).

Dimming DALI data points

1. Select the data point's checkbox Overwrite.
   - Manual operation with + and - is enabled.
2. Click + or -.
   - The dimming value is increased or reduced at 10% increments. The new value is displayed.
Noting results

1. Click the column **State**.
   Select the applicable test results.

2. Enter the desired commend in column **Comment**.
   Complete your entries by pressing <ENTER>.
   Note: The comment is transferred to ABT following read back of data.
11 PL-Link identification

PL-Link identification displays the current status of the PL-Link bus and the configuration of PL-Link devices. You can start/stop the bus and configure PL-Link devices.

Prerequisite

- PL-Link is selected in the upper navigation pane.
- Identification is selected in the left navigation pane.

Starting or stopping PL-Link

- Click Run or Stop.
  - The PL link bus is started or stopped, and the status displayed (operational/stopped).
  - The number of connected and configured PL-Link devices is displayed.

Restarting PL-Link

- Click Reset.
  - All PL-Link devices are reinitialized (runtime configuration, bus configuration).
  - The PL-Link bus is restarted, and the status is displayed as Operational.
  - The number of connected and configured PL-Link devices is displayed.

Configuring PL-Link devices

The PL-Link device is assigned to the engineered PL-Link device and configured (via program button on PL-Link device).

1. Click for a PL-Link data point.
  - The state Wait... is displayed. The room automation station is waiting for a PL-Link device signal (ca. 90 seconds).

2. Go to the PL-Link device on site.

3. Press the program button on the PL-Link device (depending on device type, see device data sheet).
  - The status display goes to Device is configured.
  - The PL-Link device is configured using the device configuration from the room automation station.
  - The PL-Link device transmits its serial number and version.
The status display changes to **Operational**.

**Notes:**

- If only one PL-Link device is connected to the network, the device is detected and configured automatically.
- If a PL-Link device cannot be identified, it is added to the **List of orphan devices**. See also: PL-Link not configured [➔ 29]
12 PL-Link data point test

The PL-Link data point test web page allows you to test the configured PL-Link data points and note the results (state, comment). Point test carries out On/Off commands.

Prerequisite

- PL-Link is selected in the upper navigation pane.
- Data point test is selected in the left navigation pane.
- The PL-Link bus status is Operational.

Finding PL-Link data points

The navigation functions (bottom right) allow for browsing the display. Select the number of data points to display via the number of entries (top left).

The search function (top right) searches the table for the desired characters. All PL-Link data points found are displayed in the list.

Testing PL-Link data points

1. Select the data point's checkbox Overwrite.
   - Manual operation with + and - is enabled.

2. Click + or -.
   - The positioning value is increased or reduced in increments of 10%.
   - The switching value is changed.
   - The stage value is increased or reduced.
   - Blinds: (+) up; (-) down.

Note: Symbol ! indicates a faulty value. Tooltip e.g. Out of Service or Alarm.
Noting results

1. Click the column **State**.
   Select the applicable test results.

2. Enter the desired commend in column **Comment**.
   Complete your entries by pressing <ENTER>.
   Note: The comment is transferred to ABT following read back of data.
13 PL-Link not configured

The PL-Link not configured web page shows PL-Link devices detected but not configured on the PL-Link bus. This list must be empty to successfully complete PL-Link identification.

Prerequisite

- PL-Link is selected in the upper navigation pane.
- Unconfigured is selected in the left navigation pane.
The TX-I/O status web page shows the status for the island bus and the TX-I/O devices. You can execute island bus functions.

**Prerequisite**
- TX-I/O is selected in the upper navigation pane.
- Status is selected in the left navigation pane.

**Start or stop island bus**
- Click Run or Stop.
  - The island bus is started or stopped, and the status displayed (Operational/Stopped).

**Restarting the island bus**
- Click Reset.
  - All TX-I/O modules are reinitialized (runtime configuration, bus configuration).
  - The island bus is restarted, and the status is displayed as Operational.
  - The number of connected and configured TX-I/O modules is displayed.
15 TX-I/O data point test

The Data point test web page allows you to test the configured TX-I/O data points and note the results (state, comment). Point test carries out On/Off/Multistate, and setpoint commands.

Prerequisite

- TX-I/O is selected in the upper navigation pane.
- Data point test is selected in the left navigation pane.
- The island bus status is Operational.

Finding TX-I/O data points

The navigation functions (bottom right) allow for browsing the display. Select the number of data points to display via the number of entries (top left).

The search function (top right) searches the table for the desired characters. All TX-I/O data points found are displayed in the list.

Testing TX-I/O data points

1. Select the data point’s checkbox Overwrite.
   - Manual operation with + and - is enabled.
2. Click + or -.
   - AO: The positioning value is increased or reduced in increments of 10%.
   - BO: The switching value is changed.
   - MO: The stage value is increased or reduced.
   - BlsOut: (+) blinds up; (-) blinds down.

Note: Symbol ! indicates a faulty value. The tooltip contains the cause (out of service or alarm).
Noting results

1. Click the column **State**.
   Select the applicable test results.

2. Enter the desired commend in column **Comment**.
   Complete your entries by pressing <ENTER>.
   Note: The comment is transferred to ABT following read back of data.
16 Report

The following reports can be displayed and printed. In addition, export to Excel (.xls) is possible.

Report: Field bus and devices

The report field bus and devices contains detailed information on room automation stations along with all existing field buses.

Device and network configuration

<table>
<thead>
<tr>
<th>Name</th>
<th>Bus state</th>
<th>Devices connected</th>
<th>Devices configured</th>
<th>Reliability</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLC-Link</td>
<td>Operational</td>
<td>4</td>
<td>1</td>
<td>Device not assigned</td>
</tr>
<tr>
<td>DALI</td>
<td>Operational</td>
<td>3</td>
<td>1</td>
<td>Device not assigned</td>
</tr>
<tr>
<td>TX-IO</td>
<td>Operational</td>
<td>2</td>
<td>1</td>
<td>Device missing</td>
</tr>
</tbody>
</table>

**PL-Link**

<table>
<thead>
<tr>
<th>Address</th>
<th>Name</th>
<th>Type</th>
<th>Version</th>
<th>Description</th>
<th>Serial number</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>R_4G8W15_1 ethnDev_1</td>
<td>O-FL</td>
<td>OS87.0</td>
<td>000000000002</td>
<td>Device not assigned</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>R_4G8W15_2 ethnDev_1</td>
<td>O-FL</td>
<td>OS87.0</td>
<td>000000000002</td>
<td>Device not assigned</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>R_4G8W15_3 ethnDev_1</td>
<td>O-FL</td>
<td>OS87.0</td>
<td>000000000002</td>
<td>Device not assigned</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>R_4G8W15_4 ethnDev_1</td>
<td>O-FL</td>
<td>OS87.0</td>
<td>000000000002</td>
<td>Device not assigned</td>
<td></td>
</tr>
</tbody>
</table>

**DALI**

<table>
<thead>
<tr>
<th>Address</th>
<th>Name</th>
<th>Type</th>
<th>Version</th>
<th>Description</th>
<th>Serial number</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FL_1_ethnDVIention_1</td>
<td>O-FL</td>
<td>OS87.0</td>
<td>000000000002</td>
<td>Device not assigned</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>FL_2_ethnDVIention_1</td>
<td>O-FL</td>
<td>OS87.0</td>
<td>000000000002</td>
<td>Device not assigned</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>FL_3_ethnDVIention_1</td>
<td>O-FL</td>
<td>OS87.0</td>
<td>000000000002</td>
<td>Device not assigned</td>
<td></td>
</tr>
</tbody>
</table>

**TX-IO**

<table>
<thead>
<tr>
<th>Address</th>
<th>Name</th>
<th>Type</th>
<th>Version</th>
<th>Description</th>
<th>Serial number</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>TSM815_1 Device_1</td>
<td>O-FL</td>
<td>OS87.0</td>
<td>000000000002</td>
<td>Device not assigned</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>TSM815_2 Device_1</td>
<td>O-FL</td>
<td>OS87.0</td>
<td>000000000002</td>
<td>Device not assigned</td>
<td></td>
</tr>
</tbody>
</table>

Report: Point test

The report point test contains detailed information on all data points in all existing field buses.
Prerequisite:

- **Report** is selected in the upper navigation pane.

**Displaying and printing reports**

1. Click \(\text{Ctrl}+\text{P}\).
   - The information is displayed in tables in a new pane.
   - The print dialog box opens.

2. Select the PDF printer.
   - Click OK.
   - The reports are printed.

**Exporting reports**

1. Click \(\text{Ctrl}+\text{S}\).
   - The File Download dialog box opens.

2. Select open to open the file directly in Excel.
17 Updating firmware

SSA-DNT can be used to update the firmware of a previously configured room automation station. The configuration remains available (including password). Restart the room automation station. You can update several room automation stations at the same time.

The firmware of an unconfigured room automation station can be updated also when the commissioning laptop is located in the same subnet.

Prerequisite
- The commissioning computer is connected to the network (via LAN or USB).
- The SSA DNT program opens.

Updating firmware
1. Click Update firmware (left, vertical).
   - On initial startup, the path to the firmware files must be indicated and is then saved. The path can be changed any time via Tools > Options.
   - The Update firmware window opens.

2. Click Scan network (bottom, right).
   - The discovered room automation stations and routers are displayed. (Select device on network table).

3. Select the device type.
   - Table Select firmware version only displays the firmware data for this device type.

4. Enter the password (top right).
   - Unconfigured room automation stations have the factory password.
   - Configured room automation stations use a project password.


6. Select the room automation station you want to update from Select device on network.
7. Click **Upload firmware**.
   - The room automation station firmware is updated. Restart the room automation station once or several times. The firmware is loaded correctly and completely when the device with the new firmware version is displayed after a **Network scan**.
   - The log window shows all program procedures.
   - Note: An error message is displayed in the log window if no valid password has already been entered (top right).

Note:
- Function **Load firmware** takes about 2 to 4 minutes (including restarting the room automation station).

Multiple room automation stations can be updated simultaneously using a LAN connection to the room automation station. Conversely, the USB connection is interrupted to other room automation stations on the network if the room automation station is restarted directly.
18 Defining proxy server settings

Disabling DHCP/APIPA (dynamic addressing) can cause problems when opening a web page, as this disables automatic proxy server configuration. Defining a proxy exception for the APIPA range (e.g. for unconfigured automation station or router 169.254.213.44) can resolve the problem.

Defining the APIPA range (e.g. in Internet Explorer)

1. Open Microsoft Internet Explorer:
2. Select Tools > Internet Options.
3. Click the Connections tab.
4. Click LAN settings.
5. Clear Use automatic configuration script.
6. Click Advanced.
7. Enter 169.*.
8. Click OK several times.

The browser no longer applies a proxy server to the indicated address range.
19 SSA-DNT program description

The SSA DNT (Discovery and Node Setup Tool) includes the following program elements.

**Menu**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; Close</td>
<td>Close the SSA-DNT program.</td>
</tr>
<tr>
<td>Tools &gt; Options</td>
<td>Path to the folder containing the firmware images.</td>
</tr>
<tr>
<td></td>
<td><strong>Additional file selection:</strong> Activates an input row in the Firmware update window to manually select the firmware file.</td>
</tr>
<tr>
<td>Tools &gt; Add new … configuration</td>
<td>Open the pane <strong>Add router configuration</strong>. A new device configuration can be created for a specified device type (router).</td>
</tr>
<tr>
<td>Help &gt; Contents</td>
<td>Opens the PDF help. Select the language for the PDF help via the operating system's <strong>Regional and Language Options</strong>.</td>
</tr>
</tbody>
</table>

**Taskbar (left, vertical)**

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set up node</td>
<td>Opens the <strong>Discover and set up node</strong> window.</td>
</tr>
<tr>
<td>Firmware update</td>
<td>Opens the <strong>Update firmware</strong> window. The entry field opens if no firmware library definition file is found.</td>
</tr>
</tbody>
</table>
"Discover and set up node" window

**Network connection**

- **Select the network interface.**
  - See also: Connecting a cable to the room automation station [➙ 6]

**IP settings**

- **Open the pane Network connections with the existing network connections and wizard for new connections.**
  - See also: Configuring a network connection [➙ 7]

**Select IP.**

- **Select a configured IP address for the network interface.**

**Connect Disconnect**

- Connects/disconnects a network connection (IP).

**Security**

- **Password**
  - Password to access the room automation station.
  - The password is checked automatically when a connection is established.
  - Unconfigured room automation stations have the factory password.
  - Configured room automation stations use a project password. (As the project leader).
The Select device configuration table shows all engineered room automation stations and routers.

<table>
<thead>
<tr>
<th>Select device configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Location</strong></td>
</tr>
<tr>
<td><strong>Device name</strong></td>
</tr>
<tr>
<td><strong>Device type</strong></td>
</tr>
<tr>
<td><strong>Address and port</strong></td>
</tr>
<tr>
<td><strong>Serial number</strong></td>
</tr>
<tr>
<td><strong>Device instance number</strong></td>
</tr>
</tbody>
</table>

Right-click a cell to display the following context menu.

<table>
<thead>
<tr>
<th>Context menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find the proper serial number.</td>
</tr>
<tr>
<td>Find the proper device type.</td>
</tr>
</tbody>
</table>

The Select device on network table displays all room automation stations, routers, and web servers (only Desigo TRA; does not apply to Desigo V5 automation stations) on the (IP) network.

The table values are updated upon a network scan, after pressing the service button on the device, or by configuring the device.

<table>
<thead>
<tr>
<th>Select device on network</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Message</strong></td>
</tr>
<tr>
<td>Configured</td>
</tr>
<tr>
<td>Unconfigure</td>
</tr>
<tr>
<td>Service pin pressed.</td>
</tr>
<tr>
<td>Time set Configuring Restarting</td>
</tr>
<tr>
<td>Authentication failed</td>
</tr>
<tr>
<td><strong>Device status</strong></td>
</tr>
<tr>
<td>Ready for operation</td>
</tr>
<tr>
<td>Receive wink.</td>
</tr>
<tr>
<td>Download required</td>
</tr>
<tr>
<td><strong>Location</strong></td>
</tr>
<tr>
<td><strong>Device name</strong></td>
</tr>
</tbody>
</table>
Select device on network

<table>
<thead>
<tr>
<th>Device type</th>
<th>Device type (specific to the device).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firmware version</td>
<td>Firmware version of the device (device-specific).</td>
</tr>
<tr>
<td>Address and port</td>
<td>Engineered IP address and UDP port (configured).</td>
</tr>
<tr>
<td>Serial number</td>
<td>Serial number (specific to the device).</td>
</tr>
<tr>
<td>MAC address</td>
<td>MAC address (device-specific).</td>
</tr>
<tr>
<td>Device instance number</td>
<td>...</td>
</tr>
<tr>
<td>URL Setup &amp; Service Assistant</td>
<td>http://...</td>
</tr>
</tbody>
</table>

The filter limits the network search to the selected device type.

Filter

<table>
<thead>
<tr>
<th>Filter criteria for the network.</th>
<th>Device type selection.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh</td>
<td>Searches for the selected device type on the network and lists the devices in the Select device on network table.</td>
</tr>
</tbody>
</table>

Button

<table>
<thead>
<tr>
<th>Configure/load device</th>
<th>Configure both network (node setup) and device. Load the configuration data (for field bus and field devices) in the room automation station. Prerequisite: The room automation station is not configured, device type and serial number match. See also: Configuring a room automation station [➙ 11]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete device</td>
<td>Delete network configuration, device configuration, and configuration data in the room automation station (factory default setting). See also: Configuring a room automation station [➙ 11]</td>
</tr>
<tr>
<td>Flash LED</td>
<td>Makes the LED on the room automation station flash. See also: Configuring a room automation station [➙ 11]</td>
</tr>
<tr>
<td>Scan network</td>
<td>Scan the (IP) network to discover all room automation stations and routers and display them in the Select device on network table (Desigo TRA only, no Desigo V5 automation stations).</td>
</tr>
</tbody>
</table>

Log window

Shows the individual steps carried out in the program.

Status display (lower left hand edge of pane).

Shows the connection status between commissioning computer and network (IP).
"Update firmware" window

Filter

Select device type

Searches for the selected device type on the network and lists the devices in the Select device on network table. The selectable device types are dependent on whether or not a firmware file exists for the device type. (Tools > Options)

Security

Password

Password to access the room automation station. The password is checked automatically when a connection is established.

- Unconfigured room automation stations have the factory password.
- Configured room automation stations use a project password. (As the project leader)

Select firmware version

Firmware version

Firmware version in the firmware image.

File name

File name for the firmware image.

Release info

Release information for the firmware image.
The entry field **Select firmware file manually** must be enabled via **Tools > Options: Additional file selection**.

<table>
<thead>
<tr>
<th>Select firmware file manually</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entry field</td>
</tr>
<tr>
<td><strong>Browse</strong></td>
</tr>
</tbody>
</table>

The **Select device on network** table (Desigo TRA only, no Desigo V5 automation stations) displays all room automation stations and routers on the (IP) network.

<table>
<thead>
<tr>
<th>Button</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Loading firmware</strong></td>
</tr>
<tr>
<td><strong>Scan network</strong></td>
</tr>
</tbody>
</table>

**Log window**
Shows the individual steps carried out in the program.

**Status display** (lower left hand edge of pane).
Shows the connection status between commissioning computer and network (IP).